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1 Customization Guide Overview

The Executive Scorecard CustomizationGuide provides information about the elements that the Executive

Scorecard comprises. Only a user with expertise using SAP® BusinessObjects Enterprise (BOE) applications

such as InfoView, Universe Designer, and Xcelsius should modify the BOE-based elements. This guide details

how the elements, Xcelsius components, Web Intelligence (Webi) reports, and universes, are integrated with

the Antivia XcelsiusWeb Intelligence Integration Suite to create the Executive Scorecard product.

This guide provides guidelines for modifying the existing, out-of-box objects. However, HP recommends that

you contact HP Software Support for assistance with extensive customizations. For more information about

the products, services, and support that HP Software offers, visit the HP Software Support Online web site at

http://www.hp.com/go/hpsoftwaresupport.

Executive Scorecard Architecture
Figure 1: Executive Scorecard Architecture on page 7 shows the high-level configuration of all of the

components that Executive Scorecard comprises. This guide provides details about the Xcelsius components,

Web Intelligence (Webi) reports, universes, and views used in Executive Scorecard. Table 1: Executive

Scorecard Architecture Descriptions on page 8 lists the description for each of the numbered items. Figure 2:

Executive Scorecard Data Flow on page 9 shows a more detailed view of the data flow. Table 2: Executive

Scorecard Data Flow Descriptions on page 9 provides descriptions of the data flow items.

Figure 1: Executive Scorecard Architecture
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Table 1: Executive Scorecard Architecture Descriptions

Item Description

1 Source Databases: Executive Scorecard is configured out-of-box to use data from HP Business Service Management

8.00, HPDecisionCenter 2.0.xx, HP IT Analytics Financial Planning & Analysis 2.0.x, and HP Project and Portfolio

Management 7.50.

2 The Executive Scorecard server.

3 Analytics Content Packs (BIAR files):

XD_CIO: Contains metadata and KPI reports for all four sources as well as the Executive Scorecard page analytics.

XD_BSM: Contains the universe and metric reports for the components that use Business Service Management

data.

XD_DC: Contains the universe and metric reports for the components that use DecisionCenter data.

XD_FPA: Contains the universe and metric reports for the components that use Financial Planning & Analysis data.

XD_PPM: Contains the universe and metric reports for the components that use Project and Portfolio Management

data.

4 SAP® BusinessObjects Enterprise XI 3.1 applications.

5 Executive Scorecard uses visual components from BusinessObjects Enterprise.

6 The Antivia Xcelsius Web Intelligence Integration Suite enables Executive Scorecard to retrieve data from the

BusinessObjects Enterprise server.

7 Antivia Xcelsius Web Intelligence Integration Suite applications.

8 The Executive Scorecard application.

9 Browser: Internet Explorer 7.

10 MSSQL Databases: Executive Scorecard database, BusinessObjects Enterprise CMS database, BusinessObjects

Enterprise Audit database, and Antivia Xcelsius Web Intelligence Integration Suite database.

11 Security: Lightweight Directory Access Protocol (LDAP) or Active Directory authentication.

8 Chapter 1



Figure 2: Executive Scorecard Data Flow

Table 2: Executive Scorecard Data Flow Descriptions

Item Description

1 Source databases:

FPA: SQL Server

PPM: Oracle

DC: SQL Server or Oracle

BSM: SQL Server or Oracle

2 SQL Server and Oracle views with date handling. Each view is stored in the source database.

3 Universes for each data source. The FPA and PPM universes provide date handling.

4 Metric, metadata, and key performance indicator (KPI) Web Intelligence (Webi) reports.

5 The Antivia Xcelsius Web Intelligence Integration Suite reads data automatically from a scheduled Webi report that

is cached on the BusinessObjects Enterprise server.

6 BusinessObjects Enterprise Xcelsius components that display the data in the Executive Scorecard application.

7 The BusinessObjects Enterprise (BOE) Central Management Server (CMS) database manages the universes, Webis,

and Xcelsius components.

Executive Scorecard Architecture 9





2 Work with Existing BusinessObjects Enterprise-
Based Elements

This section provides instructions for working with the existing out-of-box items that are created with

BusinessObjects Enterprise (BOE) applications: BOE Xcelsius components, BOE Web Intelligence (Webi)

reports, and BOE Universes.

BOE-Based Element Reference Information
This section provides reference information to show the relationships between the Executive Scorecard

Xcelsius components and their associatedWeb Intelligence (Webi) reports and universe files. This section also

provides the platform location for the component, Webi, and universe source files.

Xcelsius Component Naming Conventions
This section provides a list of each out-of-box component by source name. It lists the default page for the

component, and it also provides the name for the component as it appears in the Component Gallery. For

information about the corresponding data sources andWeb Intelligence reports for the components, see

Xcelsius Component andWebi Reference on page 14.

Some components are wired so that they can interact with each other on a page. For example, on the Financial

page, if you select a key performance indicator (KPI) on the Financial Scorecard (XD_Financial_Scorecard_P)

component, the Financial KPI Trend (XD_Financial_KPI_Trend_S) component displays information related

to that KPI. The Financial Scorecard component and the Financial KPI Trend components are wired so that

the Financial Scorecard component publishes information to the Financial KPI Trend component. And the

Financial KPI Trend component is wired to subscribe to the Financial Scorecard component.

Component file names are appended with the following values to indicate whether the component is a

subscriber, publisher, or a standalone component:

l _S: The component currently subscribes to another component or is configured to be a subscriber in the

future.

l _P: The component currently publishes to another component.

l _N: The component is a standalone component. It is not wired to subscribe or publish to other

components.

Source File Name and
Component Title as Shown on Default Page Component Gallery Name Default Page

XD_ActualVsPlannedCost_Vertical_S

Actual vs. Planned Cost for FY2010 (x100,000)

Actual vs. Planned Cost (Subscriber) Financial, Summary
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Source File Name and
Component Title as Shown on Default Page Component Gallery Name Default Page

XD_DiscVsNonDiscCost_Pie_S

Discretionary vs. Non-Discretionary for FY2010

(x100,000)

Disc vs. NonDisc Cost (Subscriber) Financial, Summary

XD_CapexVsOpexCost_Pie_S

Capex vs. Opex for FY2010 (x100,000)

Capex vs. Opex Cost (Subscriber) Financial, Summary

XD_DepartmentActualVsPlan_Bullet_N

Actual vs. Planned Costs Top 5 Organizations

Actual vs. Planned by Organizations Top 5 Financial

XD_Financial_Scorecard_P

No title

Financial Scorecard (Publisher) Financial

XD_Financial_KPI_Trend_S

No title

Financial KPI Trend (Subscriber) Financial

XD_Financial_Metadata_N

Financial Dashboard

Financial Metadata Financial

XD_OverallYTDProjectHealth_HorizontalStack_N

Project Health for Active Porjects

Project Health for Active Projects Program, Summary

XD_ProgramActualVsPlanned_Bullet_N

Actual vs. Planned Cost Top 5 Programs

Actual vs. Planned by Program Top 5 Program

XD_ProjectHealthByRegion_Top5_HorizontalStack_N

Project Health Top 5 Regions

Project Health by Region Top 5 Program

XD_SpendingbyBO_Pie_S

Budget Allocation by Business Objective

Budget Alloc by Business Objective

(Subscriber)

Program

XD_Program_Scorecard_P

No title

Program Scorecard (Publisher) Program

XD_Program_KPI_Trend_S

No title

Program KPI Trend (Subscriber) Program

XD_Program_Metadata_N

Program Dashboard

ProgramMetadata Program

XD_MonitoredAvailability_Pie_S

Monitored Availability to SLA

Monitored Availability (Subscriber) Service

XD_SLABreached_Vertical_S

Reported Exceptions to SLA

Reported Exceptions to SLA (Subscriber) Service

XD_SLAIncidentResponseTime_Vertical_S

Incident Response Time to SLA

Incident Response Time to SLA

(Subscriber)

Service
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Source File Name and
Component Title as Shown on Default Page Component Gallery Name Default Page

XD_ServiceActualVsPlanned_Bullet_N

Actual vs. Planned Cost Top 5 Services

Actual vs. Planned by Services Top 5 Service

XD_Service_Scorecard_P

No title

Service Scorecard (Publisher) Service

XD_Service_KPI_Trend_S

No title

Service KPI Trend (Subscriber) Service

XD_Service_Metadata_N

Service Dashboard

Service Metadata Service

XD_ProjActualVsPlannedCost_Vertical_S

Actual vs. Planned Cost Projects for FY2010 (x100,000)

Actual vs. Planned by Project (Subscriber) Summary

XD_ServicePerformanceAnalysis_Sparkline_N

Service Performance Analysis

Service Performance Analysis Summary

XD_ServiceLevelAchievementOvertime_

StackedColumn_S

Monitored Availability to SLA

Monitored Availability to SLA (Subscriber) Summary

XD_Summary_Metadata_N

Summary Dashboard

Summary Metadata Summary

Xcelsius Component Naming Conventions 13



Xcelsius Component and Webi Reference

The table below lists the corresponding default data source and the associatedWeb Intelligence (Webi) reports

and their location for eachXcelsius component.

Financial Components

Xcelsius Component
Default Data
Source

Associated Webi Report (and BOE InfoView
Folder)

XD_ActualVsPlannedCost_Vertical_S FPA XD_FPA_ActualCost (XD_FPA)

XD_FPA_PlannedCost (XD_FPA)

XD_DiscVsNonDiscCost_Pie_S FPA XD_FPA_Discretionary (XD_FPA)

XD_FPA_Non_Discretionary (XD_FPA)

XD_CapexVsOpexCost_Pie_S FPA XD_FPA_Opex (XD_FPA)

XD_FPA_Capex (XD_FPA)

XD_DepartmentActualVsPlan_Bullet_N FPA XD_FPA_ActualvsPlan (XD_FPA)

XD_Financial_Scorecard_P FPA and PPM XD_Financial_KPI (XD_Financial):

FPA Tab 1: Financial Control

FPA Tab 2: Innovation Delivery

PPM Tab 4: Unhealthy Budget Risk

FPA XD_FPA_ActualCost (XD_FPA)

XD_FPA_BusinessServiceActualCost (XD_FPA)

XD_Financial_KPI_Trend_S FPA and PPM XD_Financial_KPI (XD_Financial):

FPA Tab 1: Financial Control

FPA Tab 2: Innovation Delivery

PPM Tab 4: Unhealthy Budget Risk

FPA XD_FPA_Discretionary (XD_FPA)

XD_FPA_ActualCost (XD_FPA)

XD_FPA_PlannedCost (XD_FPA)

XD_FPA_BusinessServiceActualCost (XD_FPA)

XD_Financial_Metadata (XD_Financial)

XD_Financial_Metadata_N FPA and PPM XD_Financial_Metadata (XD_Financial)
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Program Components

Xcelsius Component
Default Data
Source

Associated Webi Report (and BOE InfoView
Folder)

XD_OverallYTDProjectHealth_HorizontalStack_N PPM XD_PPM_TotalProjectCount (XD_PPM)

XD_ProgramActualVsPlanned_Bullet_N FPA XD_Actual_vs_Plan_Top_Programs (XD_FPA)

XD_ProjectHealthByRegion_Top5_

HorizontalStack_N

PPM XD_PPM_RegionProjectHealthByBudget (XD_

PPM)

XD_SpendingbyBO_Pie_S PPM XD_PPM_BudgetofBOProjects (XD_PPM)

XD_Program_Scorecard_P PPM XD_Financial_KPI (XD_Financial):

Tab 4: Unhealthy Budget Risk

XD_Program_KPI (XD_Program):

Tab 3: % Healthy Projects

XD_BusinessObjective_ProjectCount (XD_PPM):

Tab 3: Projects aligned to Business Objectives

FPA XD_FPA_ProjectActualvsPlan (XD_FPA)

XD_Program_KPI_Trend_S PPM XD_Program_KPI (XD_Program):

Tab 3: % Healthy Projects

XD_Financial_KPI (XD_Financial):

Tab 4: Unhealthy Budget Risk

XD_BusinessObjective_ProjectCount (XD_PPM)

Tab 1: Total Project Count

Tab 3: % Project Aligned to Business Objectives

FPA XD_Summary_ProjectActualCost (XD_FPA)

XD_Summary_ProjectPlannedCost (XD_FPA)

XD_FPA_ProjectActualvsPlan (XD_FPA)

XD_Program_Metadata_N PPM and FPA XD_Program_Metadata (XD_Program)
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Service Components

Xcelsius Component
Default Data
Source

Associated Webi Report (and BOE InfoView
Folder)

XD_MonitoredAvailability_Pie_S BSM XD_BSM_Monitored_Availibility (XD_BSM)

XD_SLABreached_Vertical_S DC XD_DC_AvailabilitySLABreachCount_

AvailabilitySLATotalCount (XD_DC):

Tab 1: Breached SLA Count

Tab 2: Total SLA Count

XD_SLAIncidentResponseTime_Vertical_S DC XD_DC_IncidentResponseTime (XD_DC):

Tab 1: Achieved SLA Count

Tab 2: Total SLA Count

XD_ServiceActualVsPlanned_Bullet_N FPA XD_Actual_vs_Plan_Top_Services (XD_FPA)

XD_Service_Scorecard_P BSM and DC XD_Service_KPI (XD_Service):

BSM Tab 1: Service Avail %

BSM Tab 2: Service Response Time %

DCTab 3: % SLA Avail Breached

DC Tab 4: % SLA Response Time Achieve

XD_Service_KPI_Trend_S BSM and DC XD_Service_KPI (XD_Service):

BSM Tab 1: Service Avail %

BSM Tab 2: Service Response Time %

DCTab 3: % SLA Avail Breached

DC Tab 4: % SLA Response Time Achieve

XD_Service_Metadata_N BSM and DC XD_Service_Metadata (XD_Service)
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Summary Components

Xcelsius Component
Default Data
Source

Associated Webi Report (and BOE InfoView
Folder)

XD_ActualVsPlannedCost_Vertical_S FPA XD_FPA_ActualCost (XD_FPA)

XD_FPA_PlannedCost (XD_FPA)

XD_DiscVsNonDiscCost_Pie_S FPA XD_FPA_Discretionary (XD_FPA)

XD_FPA_Non_Discretionary (XD_FPA)

XD_CapexVsOpexCost_Pie_S FPA XD_FPA_Opex (XD_FPA)

XD_FPA_Capex (XD_FPA)

XD_ProjActualVsPlannedCost_Vertical_S FPA XD_Summary_ProjectActualCost (XD_FPA)

XD_Summary_ProjectPlannedCost (XD_FPA)

XD_ServicePerformanceAnalysis_Sparkline_N FPA XD_FPA_BusinessServiceActualCost (XD_FPA)

XD_FPA_BusinessServicePlannedCost (XD_FPA)

DC XD_DC_%SLAAchieved (XD_DC)

BSM XD_BSM_%SLABreached (XD_BSM)

XD_ServiceLevelAchievementOvertime_

StackedColumn_S

BSM XD_BSM_SLACountsCategorization (XD_BSM)

XD_Summary_Metadata_N FPA, PPM,

BSM, and DC

N/A
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Working with Xcelsius Components
Tomake sure you open and save files in the correct location for Executive Scorecard to read, follow these

instructions when you work with BusinessObjects Enterprise Xcelsius components.

1. From theWindows Start menu, click Programs > Xcelsius.

2. From the File menu in Xcelsius, selectOpen from Platform.

3. Log in to BusinessObjects Enterprise.

4. In the Open dialog box, expand theXD_Xcelsius_Source folder.

5. Click the component that you want to edit, and clickOpen.

6. Click the Info tab in the component spreadsheet. In the Connection Info table, type the Antivia URL. This

URLwill have the same server name and port number as the Executive Scorecard application.

For example: http://xd1.secure.hp.com:8080

7. If necessary, open the Object Browser pane. From the View menu, selectObject Browser.

8. In the Object Browser pane, selectAntivia Connect 1. Xcelsius displays the properties for Antivia

Connect 1 in the Properties pane on the right side of the window.

9. In the Properties pane, click Check URL tomake sure there are no errors. Xcelsius will not display any

messages if the check is successful.

10. In theDesign time connection area, type the user name and password that you used to log in to

BusinessObjects Enterprise, and then click Connect. The Design time connection changes fromDesign

time connection: Not connected toDesign time connection: Connected.

11. Make the desired changes.

12. Save a .swf file for the Executive Scorecard application, and then save the source file:

a. From the Xclesius File menu, click Export > SAP BusinessObjects Platform.

b. In the Save As dialog box, navigate to the .swf file that you want to overwrite. Select the file and click

Save. Xcelsius exports a .swf file and saves it in place of the existing version of the component.

c. From the Xclesius File menu, select Save to Platform.

d. In the Save As dialog box, navigate to the location where you want to save the source .xlf file and click

Save.

13. Log in to the Executive Scorecard application, and click Admin.

14. ClickDownload BOE components to Tomcat server. Executive Scorecard downloads to the

Tomcat application the component that you exported to the BusinessObjects Enterprise repository.

BOE Xcelsius Component Spreadsheets
The BusinessObjects Enterprise Xcelsius components use embeddedMicrosoft Excel spreadsheets to provide

the data and display properties for the component. The spreadsheets have four tabs:
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l Info: The Info tab contains general document properties, help, and Antivia XWIS connection information.

l Display: The Metric, Metadata, or KPI Display tab contains component display properties such as the title

text and alert colors that display on the component. For information about the display tab for each

component type, see Working with Xcelsius Component Display Properties on page 20.

l Connection: The Connection tab contains the data model for the component. It contains raw source data

and control values. For information about the Connection tab for each component type, see Working with

Xcelsius Component Data Models on page 36.

l Reference: The Reference tab contains hex values for the colors that are available to use for the

components.

BOE Xcelsius Component Spreadsheets 19



Working with Xcelsius Component Display Properties
Display properties such as the title text, alert colors, maximum andminimum ranges, are set in a display tab in

each BusinessObjects Enterprise Xcelsius component. You can use the Metric, Metadata, or KPI Display tab

in the embedded Xcelsius spreadsheet to change display properties such as component titles and the colors that

are used as indicators. This section describes the Metric, Metadata, or KPI Display tab for each type of

component.

l Metadata Component Display Properties on page 21

l Pie Chart Component Metric Display Properties on page 23

l Vertical Progress Bar Component Metrics Display Properties on page 25

l Horizontal Bullet Chart and Scorecard Component Metric Display Properties on page 27

l Horizontal Stacked Bar Component Metric Display Properties on page 29

l Spark Line Component Metric Display Properties on page 30

l KPI Trend Component Metric Display Properties on page 32
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Metadata Component Display Properties

On the Metadata Display tab for the metadata components you can customize the display properties for the

component.

Example

The following example shows the Metric Display tab for a metadata component. The Metadata Component

Display in Executive Scorecard graphic indicates which component metric display properties correspond to

each setting in the Metadata Display tab.

Metadata Component Metric Display Tab

Metadata Component Display in Executive Scorecard

The table below provides a description of the numbered items.

Metadata Component Display Properties 21



Item Description

1 The display period shows the period for the data that the components display on the page. The value in this column is

calculated from another cell in the spreadsheet and should not be edited.

2 The date of refresh shows the date that the last refresh report for that data source was refreshed last. The values in

these fields are calculated from other cells in the spreadsheet and should not be edited.

3 The dashboard name is the title that the metadata component displays. You can edit this text.

4 The notes in this field show in the comments section of the metadata components. You can edit this text.
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Pie Chart Component Metric Display Properties

On the Metric Display tab for the pie chart components, you can customize the component title and colors for

slices in the pie chart.

Example

The following example shows the Metric Display tab for a pie chart component. The Pie Chart Component

Display in Executive Scorecard graphic indicates which component metric display properties correspond to

each setting in the Metric Display tab.

Pie Chart Component Metric Display Tab

Pie Chart Component Display in Executive Scorecard

The table below provides a description of the numbered items.

Item Description

1 The title text appears at the top of the component. You can edit this field in the spreadsheet.

Pie Chart Component Metric Display Properties 23



Item Description

2 The subtitle text shows the period for the data. The value in this field comes from the Selected section on the

Connection tab. A formula on the Connection tab determines how many digits appear in the parenthesis, and a

formula in the subtitle field determines what to show.

3 The metrics list comes from the Name column in the Selected section on the Connection tab. Do not edit these

values.

4 The metric values come from the Value column in the Selected section on the Connection tab. Do not edit these

values.

5 This column designates the color for each slice in the pie chart. You can edit these values. Refer to the Reference tab

to find the hex values for the possible colors.
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Vertical Progress Bar Component Metrics Display Properties

On the Metric Display tab for the vertical progress bar components you can customize the display properties

for the component. The default values for the vertical progress bar components that are delivered with

Executive Scorecard use the settings that are typical for the key performance indicator (KPI).

Example

The following example shows the Metric Display tab for a vertical progress bar component. The Vertical

Progress Bar Component Display in Executive Scorecard graphic indicates which component metric display

properties correspond to each setting in the Metric Display tab.

Vertical Progress Bar Component Metric Display Tab

Vertical Progress Bar Component Display in Executive Scorecard

The table below provides a description of the numbered items.

Item Description

1 The title text appears at the top of the component.
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Item Description

2 The subtitle text shows the period for the data. The value in this field comes from the Selected section on the

Connection tab. A formula on the Connection tab determines how many digits appear in the parenthesis, and a

formula in the subtitle field determines what to show.

3 The vertical maximum and minimum indicate the top and bottom values for the progress bar.

4 You can designate the colors to use to represent good, warning, and bad. Refer to the Reference tab in the

spreadsheet for hex values for the colors.

5 The metrics come from the Connection tab. Do not edit these values.
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Horizontal Bullet Chart and Scorecard Component Metric Display
Properties

On the Metric Display tab for the horizontal bullet chart and scorecard components you can customize the

component title and the colors that are used in the bullet chart.

Example

The following example shows the Metric Display tab for a horizontal bullet chart component. The Horizontal

Bullet Chart Component Display in Executive Scorecard graphic indicates which component metric display

properties correspond to each setting in the Metric Display tab. The Metric Display tab for the scorecard

components is identical to the display tab for the horizontal bullet chart components.

Horizontal Bullet Chart Component Metric Display Tab

Horizontal Bullet Chart Component Display in Executive Scorecard

The table below provides a description of the numbered items.

Item Description

1 The title text appears at the top of the component.

2 The subtitle text appears below the title.

Horizontal Bullet Chart and Scorecard Component Metric Display Prop-

erties
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Item Description

3 The low and high end gradient colors designate the color for the background gradient, which looks gray in the

Horizontal Bullet Chart Component Display in Executive Scorecard graphic.

4 The alert colors specify the color of the horizontal line that represents the actual cost. By default, the neutral color is

not implemented.

5 The goal marker color specifies the color of the vertical line that represents the planned cost.

28 Chapter 2



Horizontal Stacked Bar Component Metric Display Properties

On the Metric Display tab for the horizontal stacked bar components you can customize the display properties

for the component. The default values for the horizontal stacked bar components that are delivered with

Executive Scorecard use the settings that are typical for the key performance indicator (KPI).

Example

The following example shows the Metric Display tab for a Horizontal Stacked Bar component. The

Horizontal Stacked Bar Component Display in Executive Scorecard graphic indicates which Component

Metric Display properties correspond to each setting in the Metric Display tab.

Horizontal Stacked Bar Component Metric Display Tab

Horizontal Stacked Bar Component Display in Executive Scorecard

The table below provides a description of the numbered items.

Item Description

1 The title text appears at the top of the component.

2 The subtitle text appears below the title.

3 You can designate the colors to use to represent good, neutral, and bad. Refer to the Reference tab in the spreadsheet

for hex values for the colors.
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Spark Line Component Metric Display Properties

On the Metric Display tab for the spark line components you can customize the component title and the colors

that are used in the bullet chart.

Example

The following example shows the Metric Display tab for a spark line component. The Spark Line Component

Display in Executive Scorecard graphic indicates which component metric display properties correspond to

each setting in the Metric Display tab.

Spark Line Component Metric Display Tab

Spark Line Display in Executive Scorecard

The table below provides a description of the numbered items.

Item Description

1 The title text appears at the top of the component.

2 The subtitle text appears below the title.
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Item Description

3 By default, these labels are not used.

4 These are the labels for the columns on the right side of the component.
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KPI Trend Component Metric Display Properties

On the KPI Display tab for the KPI trend components you can customize the data options and colors that are

used in the charts.

Example

The following example shows the KPI Display tab for a KPI trend component. The KPI Trend Component

Display in Executive Scorecard graphic indicates which component metric display properties correspond to

each setting in the KPI Display tab.
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KPI Trend Component Metric Display Tab

KPI Trend Display in Executive Scorecard
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The table below provides a description of the numbered items.

Item Description

1 The title text is passed to the component by the application. The title is received from the KPI that is selected in the

in the Scorecard component. Do not edit this value.

2 The color that represents the KPI in the bar chart. Refer to the Reference tab for the available hex color codes.

3 The color that represents the goal in the bar chart. Refer to the Reference tab for the available hex color codes.

4 The Name column in the Data Options table lists the options that become available in the drop-down list.

5 The row in the Connection tab that corresponds to the period you typed in the Name column. Enter the first value

from the Lookup column for the last period in the series. You can also use a variable to find the end of the fiscal year.

6 The Data Points column provides the start month and the number of months back to show (up to 12 data points).

7 The periods that the chart will display. Do not edit these values.

8 The KPI values for each period. These values come from the Connection tab. Do not edit them. So that they appear

red in the chart, KPI trend values that do not meet goal tolerance show as negative values in the KPI Trend column

on the right.

9 The goal values come from the Connection tab. Do not edit these values.

10 The metrics that show in the Metrics Trend bar chart. In this example, Discretionary Cost and Total Actual Cost are

shown. The metric values come from the Connection tab. Do not edit these values.

11 The metrics that are shown come from the Connection tab. Do not edit these values.

12 The metric values come from the Connection tab. Do not edit these values.

13 This column designates the color for each slice in the pie chart. You can edit these values. Refer to the Reference tab

to find the hex values for the possible colors.
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Working with Xcelsius Component Data Models
The data model for each component is contained on the Connection tab in each component spreadsheet. The

Connection tab contains raw source data and control values. This chapter provides information about the data

model for each type of component.

l Metadata Component Data Model on page 37

l Pie Chart Component Data Model on page 38

l Vertical Progress Bar Component Data Model on page 39

l Horizontal Stacked Bar Component Data Model on page 41

l Scorecard Component Data Model on page 44

l KPI Trend Component Data Model on page 45
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Metadata Component Data Model

The data model for the metadata components contains the refresh dates for each data source.

Example

The table below provides a description of the numbered items.

Item Description

1 The display period shows the period for the data that the components display on the page.

2 These are the default data sources that are configured for Executive Scorecard.
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Pie Chart Component Data Model

The data model for the pie chart components has three main areas that collect data.

Example

The table below provides a description of the numbered items.

Item Description

1 The Parameter shows the period for which the component displays data. The value in this field corresponds to a value

in the Lookup column and indicates which row of data to display in the component. The default setting for the pie

chart components is the current year.

2 The Lookup column lists the periods that are available to display data for. By default, this column shows the current

year and last 2 years, the current quarter and last 11 quarters, and the current month and last 35 months. The data

moves backwards from the current day. For example, FY-01 is last fiscal year, and FM-03 is 3 fiscal months ago.

3 The Selected section shows the data from the fiscal period columns that is returned by the Parameter value. It is a

staging area for the source data that the component displays. Do not make changes to the values in this section.

4 The set of columns on the left display data for calendar periods. The set of columns on the right display data for fiscal

periods. By default, the pie chart components use the fiscal period columns.

5 The -1 value enables the component to finish loading data before Executive Scorecard displays the component.

When the value is -1, the component displays aConnectingmessage in Executive Scorecard. Once the current data

replaces the -1, the component becomes visible and shows current data. If you change -1 to a different value,

Executive Scorecard displays the incomplete component until the component finishes loading.

6 You can use the extra columns to populate additional measures.
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Vertical Progress Bar Component Data Model

The data model for the vertical progress bar components is similar to the data model for the pie chart

components.

Example

The table below provides a description of the numbered items.

Item Description

1 The Parameter shows the period for which the component displays data. The value in this field corresponds to a value

in the Lookup column and indicates which row of data to display in the component. The default setting for vertical

progress bar components is the current year.

2 The Lookup column lists the periods that are available to display data for. By default, this column shows the current

year and last 2 years, the current quarter and last 11 quarters, and the current month and last 35 months. The data

moves backwards from the current day. For example, FY-01 is last fiscal year, and FM-03 is 3 fiscal months ago.
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Item Description

3 The set of columns on the left display data for calendar periods. The set of columns on the right display data for fiscal

periods. By default, the vertical progress bar components use the fiscal period columns.

4 The -1 value enables the component to finish loading data before Executive Scorecard displays the component.

When the value is -1, the component displays aConnectingmessage in Executive Scorecard. Once the current data

replaces the -1, the component becomes visible and shows current data. If you change -1 to a different value,

Executive Scorecard displays the incomplete component until the component finishes loading.

5 The Selected section shows the data from the fiscal period columns that is returned by the parameter value. It is a

staging area for the source data that the component displays. Do not make changes to the values in this section.
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Horizontal Stacked Bar Component Data Model

The data model for the horizontal stacked bar components is simple; most calculations for this type of

component are completed in the Web Intelligence report.

Example

The table below provides a description of the numbered items.

Item Description

1 The total number of projects.

2 The number of projects that are good (green), neutral (yellow), and bad (red).

3 The percentage of projects that are good (green), neutral (yellow), and bad (red).

4 Not implemented out-of-box.
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Horizontal Bullet Chart Component Data Model

On the Connection tab for the horizontal bullet chart components you can customize the tolerance value that

indicates whether the actual cost is in alignment with planned spending.

Example

The table below provides a description of the numbered items.

Item Description

1 Placeholders for the top five programs with the largest allocated planned cost amounts for the period. The data in

these columns comes from your data source. You can manually enter the values, if necessary.

2 The tolerance is the percentage above and below the goal (planned cost) that the actual amount can fall between and

still be in alignment with planned spending. You can edit the values in this column.

3 The score calculation determines the alert color for the actual cost line. 1= green, -1 = red, and 0 = yellow. The values

in this column are calculated from other cells in the spreadsheet.

4 Currently not used. The values in this column are calculated from other cells in the spreadsheet.

5 This column corresponds to the score calculation and lists the hex values for the color of the actual cost line. The

values in this column are calculated from other cells in the spreadsheet.

6 The performance column shows the actual cost rounded to two decimal places. The values in this column are

calculated from other cells in the spreadsheet.

7 The comparative column shows the planned cost rounded to two decimal places. The values in this column are

calculated from other cells in the spreadsheet.

8 The scale determines the values at which the background gradient color changes. The values in this column are

calculated from other cells in the spreadsheet.
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Spark Line Component Data Model

This section provides information about the data model for the scorecard components.

Example

The table below provides a description of the numbered items.

Item Description

1 The calendar periods to show on the spark line component.

2 The values for the metrics that the component displays.

3 The Lookup column lists the periods that are available to display data for.

4 The values for calendar period to show on the spark line component.

5 The actual cost and planned cost values that are used to calculate the actual versus planned cost.

6 The values for the KPIs that the scorecard component displays.
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Scorecard Component Data Model

This section provides information about the data model for the scorecard components.

Example

The table below provides a description of the numbered items.

Item Description

1 The list of KPIs for the component.

2 The value of the KPI.

3 The goal for the KPI.

4 The status and bullet columns must remain empty and in the order shown above. These columns display icons in the

scorecard component.

5 The value for that KPI in the pervious period.

6 The planned cost for the KPI. You can edit the values in this column.

7 The tolerance for the actual cost. This value indicates the range that the actual cost can fall above or below the

planned cost and still be considered on target. You can edit the values in this column.

8 Describes wether the actual cost meets the goal.

9 The calculation of the comparison between the current value of the KPI versus the value of the KPI for the previous

period.

10 Determines the color of the trend icons.

11 The scale for the background colors in the bullet charts.

12 Indicates whether the scorecard component displays the KPI.

13 This column indicates the color of the performance marker or actual cost line in the bullet chart.
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KPI Trend Component Data Model

This section provides information about the data model for the KPI trend components.

Example

The table below provides a description of the numbered items.

Item Description

1 The Selection section is a staging area for the source data that the component displays. Do not make changes to the

values in this section.

2 The period for which the component displays data. The value in this field corresponds to a value in the Lookup

column and indicates which row of data to display in the component.

3 The number of periods back from the current period to show.

4 The KPI that is selected in the Scorecard component.
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Item Description

5 Not used out-of-box.

6 The current fiscal month. This value comes from the metadata report.

7 The metrics used in the KPI calculation.

8 The options and order of the options in the component drop-down.

9 Indicates if a pie chart will be used. If you add a pie chart or change the KPI, you must change the text in the formula

for this cell as the KPI name is hard coded into the formula.

10 Not used out-of-box.

11 Indicates if the scorecard component is being used to determine the KPI.
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The table below provides a description of the numbered items.

Item Description

1 This section contains the data for each KPI. These values come from other cells in the spreadsheet or the data

source. Do not edit these values.

2 This section contains the goals for each KPI. You can edit the values in the white cells.
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Item Description

3 This section contains the data for metric 1 in the KPI. These values come from other cells in the spreadsheet or the

data source. Do not edit these values.

4 This section contains the data for metric 2 in the KPI. Type the values for the Company Revenue metric manually.

The value in each row is the revenue for the company for the corresponding period (listed in the Lookup column).

The values for the other metrics come from other cells in the spreadsheet or the data source. Do not edit these

values.

The table below provides a description of the numbered items.

Item Description

1 This column contains the KPI. The data model is set up to hold five KPIs.

2 The slice columns contain the data for the metrics that make up the pie chart.
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Working with BOE Web Intelligence Reports
You can use BusinessObjects Enterprise (BOE) InfoView to change existing Web Intelligence (Webi) reports.

Follow the recommendations inGuidelines for Modifying Web Intelligence Reports on page 49 when you

modify Webi reports.

Working with Webis
Tomake sure you open and save files in the correct location for Executive Scorecard to read, follow these

instructions when you work withWeb Intelligence (Webi) reports.

1. From theWindows Start menu, select Programs> BusinessObjects XI 3.1 > BusinessObjects

Enterprise > BusinessObjects Enterprise Java InfoView.

2. Log in to InfoView.

3. ClickDocument List.

4. ExpandPublic Folders.

5. View the report folders for Executive Scorecard. The names of the out-of-box folders are prefixed by

XD_. For information about which folder a report exists in, see Xcelsius Component andWebi Reference

on page 14.

6. Click the folder that contains the report that you want tomodify. Right-click the Webi in the right pane and

selectModify.

7. Make the desired changes, following the guidelines inGuidelines for Modifying Web Intelligence Reports

on page 49.

8. Save and close the Webi.

Guidelines for Modifying Web Intelligence Reports
If you use the Antivia XcelsiusWeb Intelligence Integration Suite (XWIS) application to push data to the

BusinessObjects Enterprise Xcelsius components, follow these guidelines when you modify Web Intelligence

(Webi) reports.

l XWIS does not readWebi customizations such as variables. It reads only the data provided by the base

Webi query. Tomake sure XWIS can read the Webis, do not use Webi customizations.

l Donot use synchronized SQL Select statements; XWIS will not read them.

l Data does not sort if the sorting is applied in the Webi. You must set up sorting in the Report tab in the

Antivia Table for eachXcelsius component.

l The key performance indicator (KPI) calculations are created in the universes, not in the Webi reports.

Note: XWIS does not upload data fromWebis to the Xcelsius component data model. Therefore, although

the data does get passed to the Xcelsius component .swf file, you cannot view the data by opening the source

component in Xcelsius.
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Working with Universes and Views
You can use BusinessObjects Enterprise (BOE) Universe Designer to change and create universe files. When

you modify the existing out-of-box universes, refer to the Universe Reference Information on page 51 and

Date Handling on page 50sections for important details about the universe files.

Working with Universes
When you work with universe files, make sure to open the files from the BOE CMS database and then export

the files back to the database after you make your changes.

To open universe files from your CMS database

1. From theWindows Start menu, click Programs> BusinessObjects XI 3.1 > BusinessObjects

Enterprise >Designer.

2. Log in to Universe Designer.

3. From the File menu inDesigner, clickOpen.

4. In the Open dialog box, navigate to the webi universes folder for your CMS, select the universe you want

to edit, and then clickOpen.

To export universe files to your CMS database

1. Save your universe changes.

2. From the File menu inDesigner, selectExport.

3. In the bottom pane of the Export Universe dialog box, select the universe.

4. ClickOK.

Date Handling
Since each data source has unique date or period dimensions, the Executive Scorecard requires the use of

customized date dimensions to standardize the date handling. The standardized date dimensions are created

using derived tables in the Financial Planning & Analysis (FPA) and Project and PortfolioManagement (PPM)

universes. The same date handling (SQL code) exists in the views for DecisionCenter (DC) and Business

Service Management (BSM) data rather than in the DC and BSM universes.

This section provides details about the date handling for Executive Scorecard data:

l The date dimensions provide three years of data, which is 36 or 51 rows to BusinessObjects Enterprise

Xcelsius. The Antivia XcelsiusWeb Intelligence Integration Suite (XWIS) requires a set number of cells

whether data is present or not.

n The 51 rows is for data that originates in FPA: 3 year values, 12 quarter values, and 36 month values.

n The 36 rows are month values for data that originates in PPM, DC, or BSM.

l A standalone date dimension produces the fixed date cells. This standalone dimension is merged with a date

dimension that is joined to the source date data.

50 Chapter 2



l A union query in the Web Intelligence (Webi) reports combines the data from the standalone derived table

with the date dimension that is joined to the source data.

l Dates are determined based on the latest date, usually the current day.

l A sort key is provided so that data can be sorted in Xcelsius.

l Since XWIS requires 36 or 51 rows of data, zero is used if some rows do not contain data.

l Variables are used to enable one derived table to read column values from other derived tables.

Universe Reference Information
This section provides reference information about the Executive Scorecard universes.

l Each data source has one universe.

l The universes contain the key performance indicator (KPI) calculations. The KPI calculations are not

created in the Web Intelligence (Webi) reports.

l Since each data source has unique date or period dimensions, the Executive Scorecard universes for FPA

and PPM data use derived tables to standardize date handling. The names of the derived tables are prefixed

withDT_. The same date handling exists in the views for DC and BSM data rather than in the DC and

BSM universes. For more information about date handling, see Date Handling on page 50.

l Each universe has anOBDC connection to the corresponding source database.

Universe Reference Information 51





3 Work with the Executive Scorecard
Customizable Workspace

Executive Scorecard provides a customizable environment for viewing information. You can add pages or

change the layout of an existing page, you can add or remove components on a page, and you can edit or

create external components.

Executive Scorecard Tools
The Executive Scorecard provides page-level and component-level tools that enable you to customize the

application.

Page Management Toolbar
The Page Management toolbar, on the upper right of the workspace, enables you to create pages, add

components to pages, and define component properties. The tools available depend on the page. Some of these

tools may not be available.

Tool Description

Click to refresh the visual elements of the work space.

Click to save changes to a page. The current page saves to the Page Gallery. A dialog box enables you to name the

page, give the page a description, and select a category for the page.

Click to open the Page Gallery. The Page Gallery contains default pages as well as pages you have created. You can

create pages, edit page definitions, or open pages from the Page Gallery. You can drag a page from the gallery to

your workspace to open the page.

Click to open a new blank page.

Click to open the current page in edit mode so that you can change the layout.

Click to open the Component Gallery, which contains default components as well as components you have added.

From the Component Gallery, you can edit component definitions or add components to a page. You can drag a

component from the gallery to a page in your workspace, then save the component on that page.

Click to define the wiring between components on a page. This determines how components interact with one

another.

Click to start a slide show of open pages. Each page is displayed for 10 seconds.
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Component Toolbar
The Component toolbar on the upper right of each component enables you to perform administration tasks

for the component. The tools available depend on the component. Some of these tools may not be available.

Tool Description

Click to open the Component Menu. The options in the menu depend on the component. Some of these options

may not be available:

Preferences: Enables you to rename a component.

Wiring: Enables you to customize how this component interacts with the other components on the page.

Refresh: Click to manually refresh the component.

Help: Click to open the component help.

Click to define filtering for the component if the component supports internal filtering.

Click to display the component in a separate popup window.

Click to collapse a component.

Click to expand a component.

Click to close a component. This removes the component from the page.

Add a Page to the Executive Scorecard
1. Click Page Gallery to open the Page Gallery.

2. In the Categories pane, click the category for the page that you want to add.

3. Select the page and clickOpen Page.

Add a Component to a Page
1. Open that page that you want to add the component to.

2. Click Components to open the Component Gallery.

3. In the Categories pane, click the category for the component that you want to add.

4. Click the component and drag it to a location on the open page.

5. Click Close to close the Component Gallery.

You can drag the components on the page to rearrange them. Then click Save to save the page.
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Create an External Component
1. Click Components to open the Component Gallery.

2. Click Add external component.

3. In the New Component window, provide these details:

n Name: Type a name for the new component.

n URL: The URL for an external component must begin with https://, http://, or ftp://.

n Description: Type a brief description of the new component.

n Categorize Component: If necessary, click Categorize Component to expand the list of categories.

Select the category or categories you want to file the new component in.

You do not need to provide Wiring Context or URL Parameter information.

4. ClickOK. The new component becomes available in the Component Gallery.

You can click the new component and drag it onto a page. Click Save to save the new component on

the page.

Edit an External Component
1. Click Components to open the Component Gallery.

2. Select the component you want to edit.

3. Click Edit Component Properties.

4. In the New Component window, edit any of these details:

n Name: Type a name for the component.

n URL: The URL for an external component must begin with https://, http://, or ftp://.

n Description: Type a brief description of the component.

n Categorize Component: If necessary, click Categorize Component to expand the list of categories.

Select the category or categories you want to file the component in.

5. ClickOK to save the changes to the component properties.
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